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Introduction: GearTrax/SolidWorks Model 
 
GearTrax interacts directly with the SolidWorks API to create solid models.  
 
Spur gears are an extrusion; a circle that is the same diameter as the addendum circle and another 
circle that is the bore.  The 1st tooth is an extrude-cut feature on the base feature.  All other teeth, if 
so chosen, are a pattern of this first tooth.  The tooth form is created with a true involute profile.  
The tooth profile is a series of points that define a spline or a series of arcs. 
 
Helical gears are made in the same manner as the spur gears with one exception.  The tooth is 
swept along a helix.  The user has the choice of either right or left-hand helix. 
 
Revolving the outside profile of the gear creates a bevel gear.  A plane is constructed tangent to 
the back cone surface.  A sketch is then created on this plane for the tooth profile.  The tooth profile 
is then drawn on the sketch.  A second sketch is created that intersects with the center of the gear.  
A point is placed on this sketch at the Pitch Apex.  These two sketches are then loft cut through the 
revolved base feature to produce the first tooth cut.  All other teeth, if so chosen, are a pattern of 
this first tooth cut. 
 
A sprocket is created by revolving the outside profile of the sprocket. If multi-strands are selected, 
then the sketch includes that geometry.  A tooth is then drawn on a sketch and is extrude-cut 
through the base feature.  All other teeth are a pattern of this first tooth cut. 
 
Gear belt (timing belt) pulleys are created revolving a profile of the gear including flanges.  A tooth 
sketch is then created through the center of the gear.  A tooth profile is drawn and extrude-cut 
though the gear or up to the flanges.  All other teeth are a pattern of this first tooth cut. 
 
Belt pulleys are created by revolving a shape of the profile of the gear. If “multi grooves” is 
selected, they are also revolved at that time. 
 
Splines may be created individually or as a pair.  Similar to spur gears, the internal spline is created 
with a pair of circles, one defining the internal diameter and the other defining the outside diameter.  
The pair of circles is mid-plane extruded to form the base feature.  A tooth space is drawn and mid-
plane cut-extruded.  All other tooth spaces are patterned from this cut.  External splines are created 
with a single circle defining the outside diameter of the spline then mid-plane extruded to form the 
base feature.  A tooth space is drawn and mid-plane cut-extruded.  All other tooth spaces are 
patterned from this cut. 
 
Mounting is a revolved feature added to the base feature. Bores with a keyway, set screws or 
bores for tapered bushing may also be selected. 
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Starting GearTrax 
 
There are two ways to start GearTrax in SolidWorks:  
 

1. Click on the ‘Start’ button, move to Program Files, Camnetics, and select GearTrax. 
 

2. Starting with SolidWorks 2001 Plus GearTrax* will run in-process therefore GearTrax 
will show up as an Add-In.  There are a few steps required to make GearTrax available 
to SolidWorks as an Add-In. 

 
• Start SolidWorks. 

 
• From the SolidWorks file menu select Open. 

 
• From the “Files of Type:” drop down box select “Add-Ins (*.dll)” 

 
• Browse the install folder for GearTrax, most likely “C:\Program 

Folders\GearTrax2005” 
 
• Select GearTrax2005.dll 
 
• Then click the Open button. 
 
• GearTrax will now be available in the SolidWorks menu tree.  Simply click on 

Camnetics then GearTrax to activate GearTrax. 
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Basic gear geometry and nomenclature 
 

 
 
 
Diametral Pitch verses Module 
 
Diametral pitch is always in inches. 
 
Pd = N/D = number of teeth to inches of pitch diameter 
 
Module pitch is always in millimeters. 
 
Module m = D/N = mm of pitch diameter per tooth 
 
1 Diametral pitch = 25.400 Module. 
 

Example: 
A gear with 10 teeth and 1.000 inch pitch diameter: 
 10 diametral pitch = 10  / 1.000in 
 
The same gear in metric: 
 2.54 module = 25.4mm / 10 

 
m = 25.4/Pd   
 
Pd = 25.4/m 
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Creating a Spur Gear 
 
To create a spur gear: 
 

 
 

• Select the appropriate standard from the Standards drop down box. 

• Select the desired pitch from the Diametral Pitch drop down box. 

• A diametral pitch or module value may be entered in the dialog box below the Standards 

drop down box. 

• In the Gear Type box select the Spur option button if not already selected. 

• Enter a value for the face width in the Face width box. 

• In the Number of Teeth box enter or use the spin box to change the number of teeth for 

the gear and the pinion. 

• Enter a value for the tooth Backlash  

• Enter a value for the Face width. 

• Check the Create Tooth Pattern if you want the tooth to be patterned. 

• If the Create Tooth Pattern is checked, the Teeth to Draw box becomes enabled. If it is 

desired to pattern the tooth with other than a full pattern then input the number of teeth to 

be drawn. This can be changed using SolidWorks after the part is drawn simply by editing 

the definition of the Tooth Pattern. 

• If the Internal gear set check box is selected, enter a value for the outside diameter.  It 

must be larger than the major diameter. 
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• Make any necessary changes to the hub mounting. 

• Click on the Finish button to complete the gear. 

 

 

Selecting a Gear Standard 
 
From the Standards drop down box select one of the standards. 
 
 
 
ANSI/AGMA Tooth Proportions 
 
This version of GearTrax supports automatic tooth thickening or long-addendum pinions and their 
mating short-addendum gears. See the section on Tooth Thinning for more information. 
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PGT Tooth Form 
 
PGT has a complete and easy to understand gearing manual specifically for plastic gears.   
 
The “Plastic Gearing” manual is available for $69.50 (1999 price) from ABA-PGT. 
 
For more information about the PGT tooth form please contact: 
 
ABA-PGT, INC. 
1395 Tolland Turnpike 
P.O. Box 8270 
Manchester, CT  06040-0270 
 
ABA  (860) 649-4591 
PGT (860) 643-6340 
FAX (860) 643-7619 
Web Site: www.abapgt.com 
 

 
 
 
DIN-867 Standard 
 
Addendum = Module x 1 
 
Dedendum = Module x 1.25 
 
Fillet Radius (Hob)= (Dedendum – Addendum) x 1.5 
 
Standard pressure angle = 20 degrees 
 
Modules between 0.3 and 75.0 
 
 
JIS B 1701-1973 Standard 
 
Addendum = Module x 1 
 
Dedendum = Module x 1.25 
 
Fillet Radius (Hob)= (Dedendum – Addendum) x 1.5 
 
Standard pressure angle = 20 degrees 
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Modules  between 0.3 and 75.0 Series No.1 through No. 3 
 
 
Gear Type Selection 
 
Select Spur, Helical R.H. or Helical L.H. gear type. 

 
 
 
Face Width 
 
Face width is the length of the spur gear tooth.  
 

 
 
 
Backlash 
 
• The Backlash specified is the reduction in circular tooth thickness.  In the case of a 10 Dp gear 

the tooth thickness without any back lash would be 0.1571 inches. With a backlash of 0.0100 
inches the tooth thickness will be 0.1471 inches. 

 
• If two gears are fabricated each with 0.0100 inches of backlash then there will be 0.0200 

inches backlash between the mating teeth. See the example below. Note: Backlash = 
circular pitch – tooth thickness, gear – tooth thickness, pinion. 
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Topping Adjustment 
 
The topping adjustment effects the outside diameter of the gear and/or the pinion. 
 
To set the topping adjustment: 
 

• Activate the Major Diameter dialog box. 

 
• Enter the topping adjustment value and click OK. 

• The OD of the gear or pinion will be reduced by twice the value entered. 

 

 

Fillet Radius, Fillet Radius Coefficient 
 
The fillet radius and fillet radius coefficient can only be modified if Non-standard pitches is selected. 
 
To set the fillet radius or fillet radius coefficient: 
 

• Activate the Fillet Radius dialog box. 
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True Involute Form Diameter 
 
The calculated value for the true involute form diameter may be viewed in the Minor Diameter 
dialog box. 
 
To view the true involute form diameter value: 
 

• Activate the Minor Diameter dialog box. 

 
 

Working Pressure Angle 
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The calculated value for the working pressure angel may be viewed in the Pressure Angle dialog 
box. 
 
To view the working pressure angel value: 
 

• Activate the Pressure Angle dialog box. 

• The working pressure angle may be different from the normal pressure angle if the gear set 

is a helical set, enlarged pinion-standard gear set or the sum of addendum modifications 

does not equal zero. 
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Creating an Enlarged Pinion with a Standard Gear 
 
You can model an enlarged pinion that will interact with a standard gear. 
 
To create an enlarged pinion: 
 

• Select the Enlarged pinion-standard gear check box. 

• GearTrax calculates the addendum modification for the pinion if the center distance is 

manually changed.  Otherwise the addendum modification or addendum modification 

coefficient must be provided.  Click the more information box in the upper right hand corner 

of the Addendum modification text box.  This will allow you to edit the value of the 

addendum modification. 
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Creating Non-Standard Pitch Spur Gears 
 
Non-standard pitches give the user optimum control over all parameters of the gear 
construction. 
 

• Select the “Non standard Pitches” option button. 
 

 
 
GearTrax2005 uses the addendum coefficient, clearance coefficient and the fillet radius coefficient 
as the basis for the gear geometry.  When switching to non-standard pitches GearTrax will display 
the current coefficient values.  You will also be asked to select to use coefficients as the basis of 
the gear geometry.  Selecting ‘no’ will give the most flexibility but enough data will need to be input 
into GearTrax for the gear to be modeled properly.  Selecting ‘yes’ will force GearTrax to use 
coefficients.  These values can be changed.  The fillet radius coefficient may be changed in the 
fillet radius dialog box. The addendum coefficient and the clearance coefficient may be changed in 
the Addendum dialog box. 
 
Many parameters of the gear are inter-related; changing one parameter may affect the values of 
other parts of the gear.  For example, changing the pressure angle will affect the value of the base 
circle.  Also changing the addendum will affect the major diameter (O.D),  the addendum 
modification and the addendum modification coefficient.  
 
The coefficient values will not change unless they are directly edited.  These values are the basis 
of all standards. 
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Some values will not change unless they are directly changed.  For example, the number of teeth 
can only be changed by directly editing the value in the box. 
 
When creating non-standard gears you may need to specify the values for the following: 
 

• Diametral pitch, module pitch or the pitch diameter 

• Number of teeth 

• Major diameter, addendum, addendum modification, or the addendum modification 

coefficient 

• Minor diameter, dedendum, dedendum modification, or the dedendum modification 

coefficient 

• Pressure angle or base diameter 

• Fillet radius or the fillet radius coefficient 

• Tooth thickness or backlash 

• Face width 
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Creating a Spur Gear Rack 
 
You can create a generic spur rack with 20 teeth. 
 
To create a spur gear rack: 
 

• Enter 999 into the Number of Teeth for the gear 

• Set the number of teeth for the pinion. 

• Click the Finish button to model the rack. 

• The pitch line is at the origin. 
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Internal Gear Sets 
 
To create an internal gear set: 
 

• Select the Internal gear set check box. 

• Minimum number of gear teeth for this standard is 28. 

• Enlarged pinion check box is disabled. 
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Selecting an AGMA Backlash Range for Spur Gears 
 
To select a backlash range: 
 

• Select a fine pitch standard. 

• Open the Backlash dialog box. 

 
 

• If you are using a fine pitch gear standard select a Fine pitch backlash designation; A 

through E or use the spin buttons to change the designation. 

• Enter a backlash value or use the spin buttons to change the backlash value.  If the value 

falls outside of the AGMA range the background color of the backlash input box changes to 

yellow or green. 

 
 
Addendum Modification 
 
Why modify the addendum? 
 
Addendum modification serves two main purposes.   

 
• Addendum modification will help avoid tip interference between the gear and the 

pinion. 
 
• The gear tooth is really just a short cantilevered beam.  For the gear set to have a 

balanced strength, the teeth of the pinion need to be stronger than that of the gear.  
Gears made of weaker materials like plastic; this may be critical to the life and the 
performance of the gear set.  See the PGT Tooth Form for more information. 

 
 

As the addendum length changes, so does the tooth width at the pitch circle.  This change in 
thickness is equal to twice the addendum change multiplied by the tangent of the pressure angle. 
Note: All width dimensions are arc lengths.  
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Addendum Modification Coefficients 
For DIN standards you can specify the addendum modification coefficient. 
 
To specify an Addendum modification coefficient:  
 

• The Addendum Modification option in the Tools>Options>Spur Gears menu must be set to  

“Manual only”. 

 

 
 
 
Tooth Thinning 
 
Tooth thinning, addendum and dedendum geometry changes to avoid under cut or interference. If 
the pinion or gear is modified, the mating gear will also require modification or change in the center 
distance. 
 
The following tooth forms may require modification to avoid under cut or interference. 
 

• 11 teeth or less with 25 degree pressure angle. 

• 17 teeth or less with 20 degree pressure angle. 

• 31 teeth or less with 14.5 degree pressure angle. 
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Machinery’s Handbook has a section on this subject titled “Increasing Pinion Diameter to Avoid 
Undercut or Interference”. 
 
Tooth thinning may be accomplished by selecting the supported ANSI/AGMA standard.  Along with 
tooth thinning/thickening the addendum and dedendum changes accordingly.  As the tooth thickens 
on the pinion, the addendum increases and the dedendum decreases in size.  Conversely, the gear 
tooth thins and the addendum decreases while the dedendum increases in size.  The whole depth 
remains constant.  
 
 
 
Inserting a Tooth Profile Sketch 
 
With GearTrax you can add multiple teeth to a single part. 
 
To insert a gear or involute spline tooth profile: 
 

• In GearTrax configure the gear or involute spline. 

• Start a new sketch In SolidWorks. 

• From the GearTrax menu select Insert then Tooth Profile Cut.  

 
 

• After the tooth cut geometry has been created by GearTrax, manually extrude cut the 

sketch using SolidWorks. 

• Pattern the tooth cut using SolidWorks. 
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Approach Length 
 
With GearTrax you can view the approach length for a spur gear set. 
 
To view the approach length: 
 

• Open the Addendum mod dialog box. 

• This assumes the pinion is always the driving gear and there is no tip relief. 
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Recess Length 
 
With GearTrax you can view the recess length for a spur gear set. 
 
To view the recess length: 
 

• Open the Addendum mod dialog box. 

• This assumes the pinion is always the driving gear and there is no tip relief. 
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Contact Ratio 
 
With GearTrax you can view the contact ratio for a spur gear set. 
 
To view the contact ratio: 
 

• Open the Addendum mod dialog box. 
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Creating a Helical Gear 
 
To create a helical gear: 
 

• Select the appropriate standard from the Standards drop down box. 

• Select the desired pitch from the Diametral Pitch drop down box. 

• In the Gear Type box select either the Helical R.H. or Helical L.H. from the drop down 

box. 

• If the shafts are not parallel you will need to switch the helical direction of one of the gears. 

When helical is the first selected the other gear is automatically specified as the other 

hand. 

• Selecting helix gear type enables the Helix angle input box.  Enter the desired helix angle.  

This value must be greater than zero. 

• To change the diametral pitch or module click on the More information button in the upper 

right hand corner of the Diametral pitch text box.  Selecting helix gear type enables the 

text boxes to be edited.  Enter the desired value in one of the four boxes.  The other values 

will update accordingly.  Click OK to apply the values. 

• Enter a value for the face width in the Face width box. 

• In the Number of Teeth box enter or use the spin box to change the number of teeth for 

the gear and the pinion. 

• Enter a value for the tooth Backlash by clicking on the More information button in the 

upper right hand corner of the Backlash text box. 

• Check the Create Tooth Pattern if you would like the tooth to be patterned. 

• If the Create Tooth Pattern is checked, the Teeth to Draw box becomes enabled. If it is 

desired to pattern the tooth other than a full pattern then input the number of teeth to be 

drawn. This can be changed using SolidWorks after the part is drawn simply by editing the 

definition of the Tooth Pattern. 

• If the Internal gear set check box is selected, enter a value for the outside diameter.  This 

value must be larger than the dedendum circle value. 

• Make any necessary changes to the hub mounting. 

• Click on the Finish button to complete the gear. 
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Transverse diametral pitch verses normal diametral pitch 
 
When creating helical gears: 
 
It is necessary to understand the difference between transverse and normal diametral pitches.  The 
normal diametral pitch is defined as normal to the cutter.  The transverse pitch is on the plane of 
rotation. 
 
Normal diametral pitch = Transverse diametral pitch / cos(helix angle) 
 
If Diametral pitches are selected, the drop down box displays the transverse pitch and the 
Diametral pitch box displays the normal pitch. 
 
If Module pitches are selected the drop down box displays the module transverse pitch and the 
Module pitch box displays the normal module. 
 
 
 
Normal pressure angle verses transverse pressure angle 
 
When creating helical gears: 
 
It may not be necessary to understand the relationship between transverse and normal pressure 
angle but understanding how those values are displayed in GearTrax may be useful.  The 
transverse pressure angle is measured in the plane of rotation and is always greater than the 
normal pressure angle.  The pressure angle displayed in GearTrax is the normal pressure angle.  
The transverse pressure angle may be displayed by clicking on the More information button in the 
upper right hand corner of the Pressure angle text box.  
 
The transverse pressure angle is effectively the real pressure angle. 
 
The normal pressure angle is defined as normal to the cutter. 
 
Transverse pressure angle = ATN(TAN(normal pressure angle) / COS(helix angle))  
 
Setting the helix angle by specifying the center distance 
 
GearTrax can set the helix angle by specifying the center distance. 
 
To set the helix angle: 
 

• Enter the value in the Center distance text box. 
 

• This changes the helix angle and transverse diametral pitch.  The normal diametral pitch 
remains unchanged. 
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Creating a Gear Belt Pulley 
 
To create a gear belt pulley: 
 

• Select the desired belt pitch from the drop down box. 

 
• Select the appropriate belt width. 

• Enter or use the spin box to change the number of teeth. Note that the pitch diameter 

changes with the belt pitch and the number of teeth. The pitch diameter is a driven 

dimension. 

• Check the Draw Flange if flanges are desired. 

• Check the Create Tooth Pattern if you want the tooth to be patterned. 

• Make any necessary changes to the Hub Mounting. 

• Click on the Finish button to complete the pulley. 
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Creating a Bevel Gear 
 
To create a bevel gear: 
 

• Select the desired Diametral Pitch from the drop down box. 

 
• Enter a value for the face width. 

• Select the appropriate tooth proportion. 

• Enter or use the spin box to change the number of teeth. 

• Enter a value for the tooth clearance. See help for standard values for different diametral 

pitches. 

• Check the Create tooth pattern if you want the tooth cut to be patterned. 

• If the Create tooth pattern is checked, the Teeth to draw box becomes enabled. If it is 

desired to pattern the tooth other than a full pattern then input the number of teeth to be 

drawn. This can be changed after the part is drawn simply by editing the definition of the 

CirPattern1. 

• Enter the pitch angle of the gear set (if other than 90). 

• To create a spiral bevel gear place a check in the Spiral bevel gear set box.  

• Set the Spiral direction.  The hand of the spiral is indicated by the direction in which the 

teeth curve away from the axis.  The mating gear is always the opposite hand. 
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• Enter the K Factor for circular tooth thickness.  This value can be found in Machinery’s 

Handbook in the 24th and earlier editions. 

• Enter a value for the Hub Mounting Surface. This value should be between the Min/Max 
Hub Mounting values. If the mounting value is not between these values the base feature 

may not revolve properly. 

• The pitch and outside diameters are driven dimensions. 

• Make any necessary changes to the Hub Mounting. 

• Click on the Finish button to complete the gear. 

 
 
Geometry of bevel gear nomenclature. 
 

 
 
 
Understanding the Bevel Gear Hub Mounting Distance 
 
To create a valid base feature for a bevel gear: 
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• The hub mounting distance must be between the minimum and maximum distances as 

shown below.   

• If the hub mounting distance is less than the minimum, the base feature may revolve but 

the surface may be cut into by the tooth feature. 

• If the hub mounting distance is greater than the maximum, the base feature will not revolve 

because of self-intersecting lines. 
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Recommended Normal Backlash for Bevel Gear Meshes 
 
AGMA Recommended backlash range for bevel gears: 

 
 
This table gives the recommended normal backlash for gears assembled ready to run. Because of 
manufacturing tolerances and changes resulting from heat treatment, it is frequently necessary to 
reduce the theoretical tooth thickness by slightly more than the tabulated backlash in order to 
obtain the correct backlash in assembly.  In case of choice, use the smaller backlash tolerances. 
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Creating a Chain Sprocket 
 
To create a chain sprocket: 
 

• Select the desired Chain Number from the drop down box. 

 
• Enter or use the spin box to change the number of teeth. 

• Check the Pointed Tooth check box if so desired. 

• Check the Create Tooth Pattern if the tooth is to be patterned. 

• If the Create Tooth Pattern is checked, the Teeth to Draw box becomes enabled. If it is 

desired to pattern the tooth other than a full pattern then input the number of teeth to be 

drawn. This can be changed after the part is drawn simply by editing the definition of the 

CirPattern1. 

• Select Standard Series or Heavy Series of sprocket. 

• If a Multi-strand sprocket is to be modeled, click on the check box. This will enable the 

Number of Strands input box. Enter the number of strands to be drawn. 

• The Pitch Diameter is a driven dimension. 

• Make any necessary changes to the Hub Mounting. 

• Click on the Finish button to complete the gear 
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Creating a Belt Pulley 
 
To create a belt pulley: 
 

• Select the desired Belt Type from the drop down box. 

 
• Check the Deep groove box if so desired. 

• Placing a check in the Multi groove check box enables the Number of grooves input box.  

• Enter a value or use the spin control to change the number of grooves to be drawn. 

• Enter a value in the Pitch Diameter box. 

• The Pulley O.D. value is a driven dimension. 

• Make any necessary changes to the Hub Mounting. 

• Click on the Finish button to complete the gear. 
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Creating a Worm Gear 
 
To create a worm gear: 
 

 
 

• Select the desired Diametral Pitch from the drop down box. 

• Select the desired Standard from the drop down box. 

• Enter a value for the face width.  To display the recommended minimum face width click on 

the “?” button. 

• Select the appropriate tooth proportion. 

• Enter or use the spin buttons to change the number of teeth. 

• Select the desired number of threads for the worm.  The gear ratio is 1: the number of gear 

teeth divided by the number of threads. 

• Select the direction of the worm gear.  Note: A right hand gear’s teeth lean to the right 

when its face is placed on a horizontal surface. 

• Check the Create Tooth Pattern if you want the tooth to be patterned.  Note: Patterning 

worm gear teeth can be a time consuming process.  You wish to limit the number of teeth 

created.  You may change this value later in SolidWorks. 

• If the Create Tooth Pattern is checked, the Teeth to Draw box becomes enabled.  If it is 

desired to pattern the tooth other than a full pattern then input the number of teeth to be 

drawn.  This can be changed in SolidWorks after the part is drawn simply by editing the 

definition of the Tooth Pattern. 

• Determine the size of the worm pitch by entering a value for the Worm Pitch Diameter or 

the Worm Helix Angle. 

• Make any necessary changes to the Hub Mounting.  

• Select Worm w/Gear to model both parts, Worm only to model just the worm or Gear 
only to model the gear. 

• Click on the Finish button to complete the gear. 
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Creating Involute Splines 
 
To create an involute spline: 
 

 
 

• Select the desired spline size from the drop down box. 

• Enter or use the spin box to change the number of teeth. 

• Select the pressure angle. 

• Select the root and fit. 

• Use the drop down box to select the class of fit. 

• When a class fit is select GearTrax calculates the tooth thickness and space width and 

prohibits the user from changing these values.  

• Enter or use the spin buttons to change the space width for the internal spline. 

• Enter or use the spin buttons to change the tooth width for the external spline 

• To have GearTrax model both parts, select Internal/External button and then the Finish 

button. 

• To have GearTrax model only the external spline select the External Only button and then 

the Finish button. 

• To have GearTrax model only the internal spline select the Internal Only button and then 

the Finish button. 
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Getting more information about the Spline 
 
 
To get more information: 
 

 
 

• Click on the small button in the upper right hand corner of the text box (if available).    This 
will open a dialog box with related information for the selected item.  Note: the GearTrax 
icon next to the text box indicates the value used for creating the geometry in SolidWorks. 
The values in the text boxes cannot be edited unless No Class is selected. 

 
 
Creating a Non-Standard Spline 
 
 
To create a non-standard spline: 
 
 

 
 

• From the drop down box in the Root and Fit frame select the No Class option.  This will 
allow the values to be edited in the dialog box. Click on the small button in the upper right 
hand corner of the text box (if available).  This will bring up a window with related 
information for the selected item.   
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Updating a Spline 
 
To update an involute spline: 
 

• Automatically updating involute splines is not available in this version of GearTrax.  

Following the steps below can redraw the tooth profile: 

 
• Open the tooth sketch and delete all of the sketch entities. 

• In GearTrax, set the desired values for the spline. 

• Click Insert and select Tooth Profile Cut. 

• Close the sketch to rebuild the part. 

 
 
 
Inserting a Spline Tooth Profile 
 
You can create a part with multiple tooth profiles. 
 
To add a tooth profile to a sketch: 
 

• Start a new sketch. 

• In GearTrax select the Spline tab. 

• Set the values for the spline. 

• In the GearTrax menu click on Insert.  Select Tooth Profile Cut. 

• GearTrax will create the sketch with the center of the spline on the origin. 
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Creating an Excel Data Sheet 
 
Allows you to create an Excel data sheet for spur/helical, bevel gears and splines.  
 
To create an Excel data sheet: 
 

• Select the Spur/Helical tab or the Spline tab. 
 
• Click Tools. Select Create Excel Data Sheet. 

 
• A new sheet will be started in Excel containing data for the current spur/helical gear or 

spline in GearTrax. 
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Reading an Excel Data Sheet 
 
Allows you to read an Excel data sheet that was previously created with GearTrax and modified 
manually.  
 
To read an Excel data sheet: 
 

• Excel must be running with the data sheet as the current document. 
• Check for multiple instances of Excel.  GearTrax will attempt to read the first instance 

only. 
 
• Select the Spur/Helical tab or the Spline tab. 
 
• Click Tools.  Select Read a Data Sheet (Excel format). GearTrax is updated with the 

information from the Excel data sheet. 
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Sending the Custom Information to an Excel data sheet  
 
Allows the user to send the Custom Information stored in any SolidWorks part file to a Excel spread 
sheet. 
 
To create an Excel Spread using the Custom Information data. 
 

• SolidWorks must be open with a part file active. 
 
• Excel must be available. 

 
• Click File>Send Custom Information to Data Sheet ( Excel format) from the GearTrax 

menu to dump the contents of the custom information data of the current SolidWorks part 
file.  This does not need to be a part file created with GearTrax. 
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Adding a mounting style to the Gear or Pulley 
 
To add a mounting style: 
 

• Select a Mounting style from the Mounting tab. 

 
• Selecting a keyway style will allow you to have GearTrax model a standard setscrew hole.  

The setscrew hole will be drawn only if a hub is being drawn. The setscrew hole will be 

centered on each of the hub(s). 

• If a bore for a split-tapered bushing is called for, check the Split Tapered Bushing button. 

Select the appropriate Split Tapered Bushing from the drop down box. 

• Note: The split-tapered bushing is not drawn only the bore and mounting holes.  See the 

Camnetics web site www.camnetics.com or the CD for libraries of standard split tapered 

bushings. 

• Select Hub 1st side and/or Hub/c’bore 2nd side.   

• Set the values for the appropriate hub. Use the Settings for: drop down box to enter 

values for each of the hubs to be drawn. 

• Click on the Finish button to complete the drive component. 

• A counter bore may be drawn on the second side by entering a negative number in the 

Hub projection / c’bore input box. 
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Opening and Saving GearTrax files 
 
Allows the user to save and open data they have entered for the current tab. 
 
To save a GearTrax file: 
 

• Click on the File>Save menu option. 
 
• Enter a file name. 
 
• Click on Save to invoke the file browser. 
 
• Browse to the folder you would like the GearTrax file saved to. 

 
• Enter a file name for the GearTrax file. 
 
• Click on the Save button to save the GearTrax file. 
 
• Or click Cancel to cancel the save option. 

 
 
To open a GearTrax file: 
  

• Click on File>Open to invoke the file browser. 
 
• Browse to the folder where the GearTrax file is located. 
 
• Click on the file name. 
 
• Click on the Open button to open the GearTrax file. 
 
• Or double click on the file name to open the GearTrax file. 
 
• Or click Cancel to cancel the open option. 
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Capturing the GearTrax Screen 
 
Allows the user to capture the GearTrax screen  
 
To Capture the GearTrax screen to a file. 
 

• To capture the current GearTrax screen to a bit map file click File>Capture GearTrax 
Screen to File.  The file will be saved at <Program file location>/Capture.bmp 

 
 
To Capture the GearTrax screen to the clipboard. 
 

• To capture the current GearTrax screen to the clip board click File>Capture GearTrax 
Screen to the Clipboard.  The user may paste the image from the clipboard to most paint 
programs. 

 
 
To Capture the GearTrax screen to the MS Paint. 
 

• To capture the current GearTrax screen to MS Paint click File>Capture GearTrax Screen 
to MS Paint.  The user may then save the image to different locations and file formats 
using MS Paint. 

 
 
To Empty the Clip Board. 
 

• To Empty the Clipboard click File>Empty Clipboard.  This will free up any memory being 
used by the clipboard. 
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Modification of Parts 
 
Spur/helical and straight bevel gears created in GearTrax can be modified.   
 
For example, you have a spur gear in an assembly and it was decided to change the tooth profile 
from a full involute 20-degree pressure angle with a 20-diametral pitch to stub involute with an 18-
diametral pitch.   
 
GearTrax can modify the tooth profile, face width and the number of teeth. 
 
Because of the complicated nature of the various involute forms, the tooth will be reconstructed 
rather than parametrically changed while other features of the gear will be parametrically changed. 
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To modify an existing part: 
 

• Make the part (gear, sprocket, etc) the active document in SolidWorks. 

• From the main GearTrax menu select the Tools option. 

• Select the Link to Active Part option. 

 
• The design information of the part is loaded into GearTrax. 

• Make the necessary changes to the GearTrax forms. 

• Modify the part by selecting Update Active Part in the GearTrax tools menu. 

• The part may also be recreated as a new part by selecting the Finish Button. 

• Changes made to the part in this fashion will require the least amount of editing to the 

assembly mates. 

• If manual changes have been made to the part prior to this, the results may be 

unpredictable.   

 
Tip: For best results, make any manual modifications to the part by adding new features and 
leaving the base features unaltered. 
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Setting the Length Units 
 
The GearTrax length setting is determined by the current SolidWorks default length setting. The 
GearTrax setting may be changed without regard to the SolidWorks setting. 
 
To set the Length Units: 
 

• Click the Tools option from the pull down menu, and then select Units. 
• Click the appropriate length unit. 
• This will set the length unit of GearTrax and will change the SolidWorks part unit setting 

when a new part is created.  
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GearTrax Options 
 
Allows you to customize GearTrax options and calculate over-pin-measurements. 
 
To set options: 
 

• Click Tools from the pull down menu, then Options. 

• Select the appropriate tab for the settings you want to change.  

• To register the new settings for only the current tab click Apply Tab. 

• To register the new settings for all the tabs click OK. 

• To exit the options without registering any changes click Cancel. 
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General Options 
 
Lets you set properties for involute sketches, tooth patterns and auxiliary sketches. 
 
To set options: 
 

• Click Tools option from the pull down menu, then Options. 

• Select the General tab. 

• Select options from the following list and make the changes that you prefer. 

• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 

 
 

 
 
 
Fix Involute Sketch 
 
Lets you specify if GearTrax should fix the entities of the involute sketch as GearTrax creates the 
model. 
 
To set options: 
 

• Click Tools option from the pull down menu, then Options. 

• Select the General tab. 

• Select Fix Involute Sketch check box if you would like GearTrax to fix the involute sketch 

entities as the model is created.  Fixing the involute sketch may prevent unintentional 

dragging of the sketch points.  The gear will take longer for SolidWorks to generate with 

this option set. 
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Tooth Pattern 
 
Lets you specify if and when GearTrax will inquire before the tooth pattern is created. 
 
To set options: 
 

• Click Tools option from the pull down menu, then Options. 

• Select the General tab. 

• Select Never inquire before creating tooth profile if GearTrax should always create the 

tooth profile without interrupting the modeling process. 

• Select Always inquire before creating a tooth pattern if you would like GearTrax to 

inquire before any tooth pattern is created. 

• Select Inquire only when tooth number exceeds if you would like GearTrax to inquire 

before creating a tooth profile above a certain number of teeth.  Selecting this option 

enables the text box.  Enter that value in the text box. 

 
 
 
Auxiliary Sketches 
 
Lets you specify the creation of an auxiliary sketch. 
 
To set options: 
 

• Click Tools option from the pull down menu, then Options. 

• Select the General tab. 

• Select the Draw Auxiliary Sketches check box for GearTrax to create a sketch as the 

model is created. 

• Select Pitch Diameter if you would like the pitch diameter included on the sketch. 

• Select Addendum Diameter if you would like the addendum diameter included on the 

sketch.  This option will be ignored if it does not apply to the product being modeled. 

• Select Dedendum Diameter if you would like the dedendum diameter included on the 

sketch. This option will be ignored if it does not apply to the product being modeled. 

• Select Base Diameter if you would like the base diameter included on the sketch. This 

option will be ignored if it does not apply to the product being modeled. 

• Select Hide sketch on creation if you would like GearTrax to hide the sketch as the model 

is created. 

 
 
 
NetHASP Check 
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Lets you specify if GearTrax should check for a NetHASP at startup. 
 
To set options: 
 

• Only use this option is you have a Camnetics NetHASP on the network. 

• Click Tools option from the pull down menu, then Options. 

• Select the General tab. 

• Select the Check for NetHASP on startup check box if you would like GearTrax to check 

for a NetHASP on startup.   

• Selecting this option without a NetHASP present or functioning will delay the startup of 

GearTrax as the network is searched for the presence of the NetHASP. 

• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 

 
 
Version Check 
 
Lets you specify if GearTrax should check for a more recent release of GearTrax at startup. 
 
To set options: 
 

• Click Tools option from the pull down menu, then Options. 

• Select the General tab. 

• Select Do not check web site for a newer version on start-up if you do not want 

GearTrax to check the web site for a more recent release.  If left unchecked and you have 

access to the internet, GearTrax will look at the web site for a more recent release and 

notify you if one exists.  You will need to manually download the latest file and go through 

the installation procedure.  This is not done automatically. 

 
 
2d Spline Creation Over ride 
 
Lets you specify if GearTrax should automatically over ride the creation of 2d splines with a series 
of arcs. 
 
To set options: 
 

• Click Tools option from the pull down menu, then Options. 

• Select the General tab. 

• Select the Automatically over ride the creation of 2d splines with arcs if you would like 

GearTrax to create tooth profiles with arcs rather than 2d splines.   

 
 
SolidWorks Version 
 
Lets you specify which version of SolidWorks should be used with GearTrax. 
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To set options: 
 

• Click Tools option from the pull down menu, then Options. 

• Select the General tab. 

• Use the drop down box to specify which version of SolidWorks to use with GearTrax.  

 
Part Template File 
 
Lets you specify a template to be used when starting a new GearTrax part. 
 
To set options: 
 

• Click Tools option from the pull down menu, then Options. 

• Select the General tab. 

• Browse to the location of the template files and double click on the desired template. 

 
 
 
 
 
Tooth Creation 
 
Two methods are available for generating the tooth form, splines or arcs.   
 
If the gear geometry will be used in conjunction with a CAM system, arcs may be the wise choice.  
Most CAM systems will convert splines to a series of straight lines, while the arcs will remain as 
arcs. 
 
A pair of splines is defined by a series of points along the tooth form.  The more complex the tooth 
form, the more points are used to create the tooth spline.  The spline is extruded to create the tooth 
feature.  Splines are the faster of the two options in SolidWorks. 
 
A series of arcs are used to create the tooth form.  The more complex the tooth form is, the more 
arcs are used to create the tooth profile. 
 
For help in setting GearTrax to create the tooth profile in arcs or splines, see Spur Gear Options. 
 
Also see Manufacturing Methods for Spur/Helical Gears. 
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Spur Gear Options 
 
Allows you to customize Spur Gear Annotations for drawings and how the tooth profile is created. 
 
To set options: 
 

• Click Tools, then Options. 

 
• Select the Spur Gears tab.  Selecting a Class option from the drop down box will “check” 

the appropriate boxes for that standard.   Add or subtract from the check boxes for the 

desired annotations when adding a note on a drawing.  These options are not saved with 

the part file and will need to be set at the time the note is created on the drawing. 

• Tooth Creation. To create the tooth profile with a spline, select the Spline option or select 

the Arcs option to create the tooth profile with a series of arcs. 

• Typically, creating the tooth with a spline will increase the performance of rebuilds but may 

make it more difficult if this geometry is use with a CAM system for fabrication. 

• Creating the gear with arcs will allow the tooth profile to be mated in an assembly, but may 

require more time for rebuilds.  Arcs may also be more appropriate for use with some CAM 

systems for fabrication. 

• Keyway Position.  To position the keyway on the tooth space center place a check in the 

appropriate box for the gear or the pinion. If left unchecked the keyway will be positioned 

on the tooth center.  A keyway must be selected from in the mounting tab. 

• Class. Selecting a class in this tab sets up the appropriate check boxes for a note.  It does 

not effect the gear creation, only what is displayed in the annotation. 

• Addendum Modification.  Select either Automatic only or Manual only.  If automatic only 

is select GearTrax, will enter the minimum modification recommended for certain 

standards, if available.  If manual only is select then GearTrax will allow changes to the 

addendum modification and the addendum modification coefficient values. 
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• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 

 
 
Helical Gear Options 
 
Allows you to customize Helical Gear Annotations for drawings. 
 
To set options: 
 

• Click Tools, then Options. 

• Select the Helical Gears tab. 

 
• Selecting a Class option from the drop down box will “check” the appropriate boxes for that 

standard.   Add or subtract from the check boxes for the desired annotations when adding 

a note on a drawing.  These options are not saved with the part file and will need to be set 

at the time the note is created on the drawing. 

• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 
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Bevel Gear Options 
 
Allows you to customize Bevel Gear Annotations for drawings. 
 
To set options: 
 

• Click Tools, then Options. 

• Click the Bevel Gears tab. 

 
• Selecting a Class option from the drop down box will “check” the appropriate boxes for that 

standard.   Add or subtract from the check boxes for the desired annotations when adding 

a note on a drawing.  These options are not saved with the part file and will need to be set 

at the time the note is created on the drawing. 

• To create the tooth profile with a spline, select the Spline option or select the Arcs option 

to create the tooth profile with a series of arcs. 

• Addendum Modification.  If this option is unchecked GearTrax will modify the addendum 

based on Gleason standards.  If this option is check the user will need to specify the 

desired addendum modification. 

• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 
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Sprocket Options 
 
Allows you to customize Sprocket Annotations for drawings. 
 
To set options: 
 

• Click Tools, then Options. 

• Select the Sprockets tab. 

 
• Add or subtract from the check boxes for the desired annotations when adding a note on a 

drawing.  These options are not saved with the part file and will need to be set at the time 

the note is created on the drawing. 

• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 
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Gear Belt Options 
 
Allows you to customize Gear Belt Annotations for drawings. 
 
To set options: 
 

• Click Tools, then Options. 

• Select the Gear Belts tab. 

 
• Add or subtract from the check boxes for the desired annotations when adding a note on a 

drawing.  These options are not saved with the part file and will need to be set at the time 

the note is created on the drawing. 

• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 
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Belt Pulley Options 
 
Allows you to customize Belt Pulleys for drawings. 
 
To set options: 
 

• Click Tools, then Options. 

• Select the Belt Pulleys tab. 

 
• Add or subtract from the check boxes for the desired annotations to be added to the note 

on a drawing.  These options are not saved with the part file and will need to be set at the 

time the note is created on the drawing. 

• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 
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Worm Gear Options 
 
Allows you to customize Worm Gear Annotations for drawings. 
 
To set options: 
 

• Click Tools, then Options. 

• Select the Worm Gears tab. 

 
• Selecting a Class option from the drop down box will “check” the appropriate boxes for that 

standard.    

• Add or subtract from the check boxes for the desired annotations when adding a note on a 

drawing.  These options are not saved with the part file and will need to be set at the time 

the note is created on the drawing.  

• To create the tooth profile with a spline, select the Spline option or select the Arcs option 

to create the tooth profile with a series of arcs. 

• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 

•  
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Spline Options 
 
Allows you to customize Spline Annotations for drawings and how the tooth profile is created. 
 
To set options: 
 

• Click Tools, then select Options. 
• Click on the Splines tab. 

 

• The involute spline tooth cut may be created with splines or a series of small arcs.  Select 

the appropriate option button. 
• Add or subtract from the check boxes for the desired annotations to be added to the note 

on a drawing.  These options are not saved with the part file and will need to be set at the 

time the note is created on the drawing. 

• Click OK to accept the changes; click Cancel to discard the changes and exit the dialog 

box; click Apply Tab to accept the changes for this tab only. 
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Measurements Options 
 
Allows you to calculate the over the pin measurements. 
 
To set options: 
 

• Click Tools, then Options. 

• Select the Measurements tab. 

 
• Click the Calculate Van Keuren Pin Diameter button to use the industry standard for pin 

sizes. 

• You can calculate the “Over the Pin Measurement” with a desired pin size by entering that 

value into the Pin Diameter text box.  WARNING: GearTrax will not inform you if the pin 

size is usable. 

• GearTrax can calculate the tooth thickness for spur, helical or spline by entering the pin 

diameter and then the measurement over or under pins.   

• The standard Chordal measurements and the Number of teeth to gage over is 

displayed for external spur gears and pinions. 

 
 
How does GearTrax store these values? 
 

• GearTrax places the measurement values in the custom information properties of the part.  

When GearTrax creates the part model, these values will be recalculated using the Van 

Keuren Pin Diameters.  If you want to use a specific pin diameter other than the Van 

Keuren value, enter the diameter and check the box Use the value above when creating 
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the model before creating the model.  This will prevent GearTrax from recalculating using 

the Van Keuren pin diameter during the creation of the gear or spline. 

• If you would like to change these values later you will need to manually change the values 

in SolidWorks.  Click File, Properties, Custom tab.  See “Summary Info” help section in 

SolidWorks for more information. 

• These values can be added to a drawing by checking the appropriate boxes in the spur 

gears option dialog box.  The boxes checked will be used when inserting an annotation to 

a drawing. See Inserting a Drawing Annotation for more information. 

 
 
 
Calculating a Tooth Thickness 
 
GearTrax can be used to calculate the tooth thickness when the over the pin dimension and pin 
diameters are known. 
 
To calculate the tooth thickness: 
 

• Select either the Spur/Helical tab or the Spline tab. 

• Specify the number of teeth, diametral pitch or the Module 

• Open the Measurements tab in the Options menu. 

• Specify a pin diameter for the pinion, gear or the internal or external spline. 

• Enter a value in one of the four over or under the pin measurement text boxes. 

• GearTrax will return a message with the calculated tooth thickness or a message saying 

the dimension could not be calculated. 

 
 
Between Pins Example 
 

• Between pin measurements can be created manually and can be used to verify data. 

• Create a new sketch on the face of the gear. 
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• Select a single tooth spline and create an offset entity equal to ½ of the pin diameter. 

• Select the spline on the other side of the tooth space.  Create another offset entity equal to 

½ the pin diameter. 

• Add a point on one of the new offset entities. 

• Add a coincident relationship between the point and the offset entity. 

• Add a circle with the center on the point.  Dimension the circle equal to the pin diameter. 

• Add a centerline to the sketch. 

• Add a midpoint relationship between the centerline and the center of the gear. 

• Add a coincident relationship between the pin outside diameter and an end point of the 

centerline. 

• Add a coincident relationship between the pin center point and the centerline. 

• Add the between the pins dimension by adding a dimension to the length of the centerline. 

 

 
• Sample of a manual verification of between the pins measurements using SolidWorks. 

 
• If the gear has an odd number of teeth you will need to create the sketch with 2 pins. 

 

 
Sample of a manual verification of over the pins measurements using SolidWorks. 
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General Formula for Checking External and Internal Spur Gears by 
Measurement over Pins 
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Selecting a Manufacturing Method for Spur/Helical Gears 
 
Allows you to specify the Manufacturing method for spur/helical gears. 
 
To set options: 
 

• Click Tools, then select Options. 
• Click on the Manufacturing tab. 

• Select one of the three manufacturing methods by clicking on the picture: 
• Hobbing. Involute profile extends to the TIF diameter.  Under and over cutting of the tooth 

profile by the hob is duplicated. 

• Full involute.  Involute profile extends to the base circle.  No under or over cutting of the 

tooth as the hob may produce. 
• Full fillet radius (hobbing).  Fillet radius is enlarged over the standard fillet radius.  This 

also increases the dedendum slightly.  For coarse and fine pitch standards only. This is a 

deviation from the standards. 
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Select Company Standards for Addendum, Clearance and Fillet 
Radius Coefficients 
 
Allows you to specify three company standards. 
 
To set standards: 
 

• Click Tools, then select Options. 
• Click on the Company Standards tab. 
• Use the arrow buttons to index through the three different standards. 

• Change the title of the standard, if desired. 
• Select manufacturing method to be the default for the standard 

• Input the values for  

o Addendum coefficient 

o Clearance coefficient 

o Fillet radius coefficient 

o Pressure angle 

• Press the record button or index to the next standard. 

• These standards will be available for spur and helical gears. 
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Calculating Addendum and Clearance Coefficients 
 
This may help decipher 3rd party specifications with limited information. 
 
To calculate the coefficients: 
 

• Click Tools, then select Options. 
• Click on the Company Standards tab.  
• Enter the values for the following: 

o Pitch diameter 
o Number of teeth 
o Addendum length 

� Note: Addendum  = (major diameter – pitch diameter) / 2 
o Dedendum length 

� Note: Dedendum = (pitch diameter – minor diameter) / 2 

o Modification, this is sometimes called tool advance.  It’s normally negative for the 

gear and positive for the pinion. 
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Inserting a Drawing Annotation 
To insert a note on a drawing: 
 
Define the note by setting the options for the product.  See GearTrax Options 
 

 
 
From the GearTrax menu select Insert and then Insert Annotations to display the Annotations 
dialog box. 
 

 
 
To set Annotation options: 
 

• Place a check in the appropriate box to have annotations created using all upper case 

letters. 

• Place a check in the appropriate box to have annotations created using Excel. 

 
 

To insert an Annotation to a part or a drawing: 
 

• From the Annotations type drop down box select the appropriate annotation type. 

• If the desired annotation is for an inserted tooth cut profile then: 

• Place a check in the Use Pre-string check box. 

• The per-string character needs to be specified.  Enter the letter in the box or use the up-

down arrows to change the letter.  If you are unsure of which letter to use you may want to 

review the Custom Properties of the part in SolidWorks. 

 
 

To delete the custom information for an inserted tooth cut: 
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• Place a check in the Use Pre-string check box. 

• Set the per-string character for the desired set of custom properties. 

• Press the Delete key 

 
 

 
 
Sample of the Summary Information window in SolidWorks. 
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